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1.1 The cosFileTransfer Application

1 cosFileTransfer User's Guide

The cosFileTransfer Application is an Erlang implementation of the OMG CORBA FileTransfer Service.

1.1 The cosFileTransfer Application

1.1.1 Content Overview
The cosFileTransfer documentation is divided into three sections:

* PART ONE - The User's Guide
Description of the cosFileTransfer Application including services and a small tutorial demonstrating the
development of asimple service.

* PART TWO - Release Notes
A concise history of cosFileTransfer.

* PART THREE - The Reference Manual
A quick reference guide, including a brief description, to all the functions available in cosFileTransfer.

1.1.2 Brief description of the User's Guide
The User's Guide contains the following parts:

e cosFileTransfer overview
e cosFileTransfer installation
e Atutoria example

1.2 Introduction to cosFileTransfer

1.2.1 Overview
The cosFileTransfer application is aFileTransfer Service compliant with the OM G Service CosFileTransfer.

Purpose and Dependencies
If aVirtual File System is started as'FTP, the inets-2.5.4 application, or later, must be installed.

cosFileTransfer is dependent on Orber, which provides CORBA functionality in an Erlang environment, and
cosProperty.

Prerequisites

To fully understand the concepts presented in the documentation, it is recommended that the user is familiar with
distributed programming, CORBA, the Orber and cosProperty applications.

Recommended reading includes CORBA, Fundamentals and Programming - Jon Segel and Open Telecom Platform
Documentation Set. It is also helpful to have read Concurrent Programming in Erlang.
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1.3 Installing cosFileTransfer

1.3 Installing cosFileTransfer

1.3.1 Installation Process

This chapter describes how to install cosFileTransfer App in an Erlang Environment.

Preparation

Before starting the installation process for cosFileTransfer, the application Orber must be running and
cosProperty instaled by using cosProperty:install (). Please note that it is NOT necessary to use
cosProperty:install_db() for running the cosFileTransfer application.

Configuration
When starting the cosFileTransfer application the following configuration parameters can be used:

» buffert_size - default is 64000. This option determine how many bytes will be read at atime when transferring
files.

1.4 Using the File Transfer Service

1.4.1 Overview
This chapter describes how two File Transfer Service applications interact.

Components

There are several waysthe OMG File Transfer Service can be used. Below one scenario is visualized:

TCP/P

ORB SSL ORB
NESiLocal Disk

Figure 4.1: Figure 1: The File Transfer Service Components.
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1.4 Using the File Transfer Service

e Source ORB: thisisthe ORB we want to transfer afile from/via and it holds an object reference to a Virtual
File System (VFS) which, in this example, represents an FTP server.

» Target ORB: the goal may be, for example, to transfer a new file or append to an existing file placed at the
location that this ORB's VFS represents. In this scenario it is the local disk or the NFS.

e Transport Protocal: initially the ORB's, i.e., target and source, communicate via normal CORBA requests to
determine whether or not they can communicate. If the File Transfer Service's have one, or more, Tr anspor t
Pr ot ocol in common the datawill be streamed using this protocol. The cosFileTransfer application currently
supports TCP/ | P and SSL.

Which type of file system the VFS is supposed to represent is determined by the options given when creating it, which
isaso how onedeterminewhich Tr ansport Pr ot ocol touse. Hence, the source and target VS described above
can be started by invoking, respectively, the following operations:

1> SVFS
2> TVFS

cosFi | eTransf er App: create_VFS(' FTP', [], Host, 21, [{protocol, tcp}]),
cosFi | eTransf er App: creat e_VFS({' NATI VE' , ' cosFil eTransfer NATI VE file'},
[], GherHost, 0, [{protocol, tcp}]),

Naturally can any combination of VFS-types be used and it is also possible to use own drivers, i.e., {' NATI VE' ,
"MyDriver'}.

After creating necessary VFS' s we can login in and perform operations on files and directories residing on each file
system.

How To Use SSL

To be able to use SSL as transport protocol a few configuration parameters must be set. The required parameters
depend on if Orber is the target or/and the source ORB. However, the SSL_CERT_FILE variable must be defined
in both cases.

Setting of aCA certificate file with an option does not work due to weaknessesin the SSL eay package. A work-around
in the ssl application is to set the OS environment variable SSL_CERT_FILE before SSL is started. However, then
the CA certificate file will be global for al connections (both incoming and outgoing calls).

Configurations when cosFileTransfer is Used as Target
The following three configuration variables can be used to configure cosFileTransfer's SSL target behavior.

» sd_server_certfilewhich isapath to afile containing a chain of PEM encoded certificates for cosFileTransfer
astarget.

« s8_server_verify which specifiestype of verification: 0 = do not verify peer; 1 = verify peer, verify client once,
2 = verify peer, verify client once, fail if no peer certificate. The default valueis 0.

» sd_server_depth which specifies verification depth, i.e. how far in achain of certificates the verification
process shall proceed before the verification is considered successful. The default valueis 1.

There also exist anumber of API functions for accessing the values of these variables:

e coskileTransferApp:ss_server_certfile/O

e coskileTransferApp:sd_server verify/O

e cosFileTransferApp:sd_server_depth/O

Configurations when cosFileTransfer is used as Source

Below isthelist of configuration variables used when cosFileTransfer act as the source application.

» sd_client_certfilewhich is a path to afile containing a chain of PEM encoded certificates used in outgoing
cals.
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1.5 cosFileTransfer Examples

e sd_client_verify which specifies type of verification: 0 = do not verify peer; 1 = verify peer, verify client once,

2 = verify peer, verify client once, fail if no peer certificate. The default valueisO.

« sd_client_depth which specifies verification depth, i.e. how far in achain of certificates the verification process

shall proceed before the verification is considered successful. The default valueis 1.

There also exist anumber of API functions for accessing the values of these variablesin the client processes:

e cosFileTransferApp:sd_client_certfile/O
e cosKileTransferApp:ssl_client_verify/0
e coskileTransferApp:sd_client_depth/O

1.5 cosFileTransfer Examples

1.5.1 A tutorial on how to create a simple service

Initiate the application
To use the complete cosFileTransfer application cosProperty must be installed.

How to run everything

Below isa short transcript on how to run coskFileTransfer.

%hb Start Miesia and O ber

mesi a: del et e_schema([ node()]),
mesi a: creat e_schema([ node()]),
orber:install ([node()]),

mesi a: start (),

orber:start(),

%6 The File Transfer Service depends on the cosProperty
% appl i cati on. Hence, we nust install cosProperty first.
%o lt's NOT necessary to invoke cosProperty:install_db().
cosProperty:install(),

%Wolnstall File Transfer Service in the |FR
cosFil eTransfer:install (),

%6 Now start the applicati on and necessary services.
cosFil eTransfer:start(),

%6 Create two Virtual File Systems respectively representing an FTP-
%6 and the local NFS file system
VFSFTP = cosFil eTransfer App: create_VFS(' FTP', [], FTPHost, 21),
VFSNATI VE = cosFi | eTr ansf er App:
create_VFS({' NATIVE , 'cosFileTransferNATIVE file'},
[T, MyLocal Host, 0),

%6 Login to each system
{FSFTP, DirFTP} = 'CosFileTransfer_Virtual Fil eSystem :
| ogi n(VFSFTP, "nyld", "nyPwd", "myAccount"),
{ FSNATI VE, DirNATI VE} = 'CosFil eTransfer_Virtual Fil eSystemn :
| ogi n( VFSNATI VE, "nyld", "myPwd", "myAccount"),

%Woelf we want to copy a file fromthe NFS to the FTP we nust first

%ocreate a File object which contains its attributes.

Target = ' CosFil eTransfer_Fil eTransfer Session':create_fil e( FSFTP,
[“/", "ftp", "incomng", "targetFile"])),
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1.5 cosFileTransfer Examples

#' CosFil eTransfer_Fil eWapper' {the_file = Dir} =
%% Lookup the file we want to copy.
Fi | eWapper = ' CosFil eTransfer_Fil eTransfer Sessi on': get_fil e( FSNATI VE,
[*/", "home", "nyld", "sourceFile"]),
Source = Fil eWapper#' CosFil eTransfer_Fi|l eWapper'.the_file,

%%b Now we are ready to transfer the file. Please note that we nost

%hbcall the source Session object.
' CosFi |l eTransfer_Fil eTransf er Sessi on' : transf er (FSNATI VE, Source, Target),
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1.5 cosFileTransfer Examples

2 Reference Manual

The cosFileTransfer Application is an Erlang implementation of the OMG CORBA File Transfer Service.
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cosFileTransferApp

cosFileTransferApp

Erlang module

To get access to the record definitions for the structures use:
-include_lib("cosFileTransfer/include/*.hrl").

This module contains the functions for starting and stopping the application.

Exports

install() -> Return
Types:
Return = ok | {'EXIT', Reason}

This operation installs the cosFileTransfer application. Note, the cosPr oper t y application must be installed prior
to invoking this operation.

uninstall () -> Return
Types:
Return = ok | {' EXIT', Reason}
This operation uninstalls the cosFileTransfer application.

start() -> Return
Types:

Return = ok | {error, Reason}
This operation starts the cosFileTransfer application.

stop() -> Return
Types:

Return = ok | {error, Reason}
This operation stops the cosFileTransfer application.

create_ VFS(Type, Content, Host, Port [,Options]) -> Return

Types:
Type = "FTP' | {'NATIVE , 'cosFileTransferNATIVE file'} | {' NATIVE',
MyModul e}

Content = []
Host = string(), e.g. "nyHost @wyServer" or "012.345.678.910"
Port = integer()

Options = [Option]

Option = {protocol, Protocol} | {connect_tineout, Seconds}
Protocol =tcp | ssl

Return = VFS | {' EXCEPTION, E}

VES = #objref
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cosFileTransferApp

This operation creates a new instance of a Virtual File System. The Ty pe parameter determines which type we want
the VFSto represent. 'FTP mapsto thel NETS ftp implementation, while{'NATIVE', 'cosFileTransferNATIVE_file}
usesthef i | e module. It is also possible to implement own mappings which are activated by supplying {' NATIVE',
MyModule}. The MyModule module must export the same functions and behave in the same way as the INETS ftp
module, and an operation named open( Host, Port),whichshal return{ ok, Pid} or{error, Reason}.

If no Opt i ons are supplied the default setting will be used, i.e., tcp and 60 seconds.
The Cont ent parameter is currently ignored by must be supplied as an empty list.

ssl _server_certfile() -> string()

This function returns a path to afile containing a chain of PEM encoded certificates for the cosFileTransfer as target.
Thisis configured by setting the application variable ssl_server_certfile.

ssl _client _certfile() -> string()

Thisfunction returns apath to afile containing a chain of PEM encoded certificates used in outgoing calls. The default
value is configured by setting the application variable ssl_client_certfile.

ssl _server _verify() ->0 | 1| 2

This function returns the type of verification used by SSL during authentication of the other peer for incoming calls.
It is configured by setting the application variable ssl_server_verify.

ssl _client_verify() ->0 ] 1| 2

This function returns the type of verification used by SSL during authentication of the other peer for outgoing calls.
The default valueis configured by setting the application variable ssl_client_verify.

ssl _server _depth() -> int()

This function returns the SSL verification depth for incoming calls. It is configured by setting the application variable
ssl_server_depth.

ssl _client_depth() -> int()

This function returns the SSL verification depth for outgoing calls. The default value is configured by setting the
application variable s3_client_depth.
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CosFileTransfer_File

CosFileTransfer_File

Erlang module

To get access to the record definitions for the structures use:
-include_lib("cosFileTransfer/include/*.hrl").

This module also exports the functions described in:
e CosPropertyService PropertySetDef in the cosProperty application.

Exports

'_get_name' (File) -> string()
Types:
File = #objref
This read only attribute represents the target object's associated name.

' _get _conplete file nane' (File) -> string()
Types:
File = #objref
Thisread only attribute represents the target object's associated absolute name.

' _get _parent' (File) -> Directory
Types:
File = Directory = #objref
Thisread only attribute represents the target object's container. In some cases a NI L object will be returned.

' _get _associated _session' (File) -> FileTransfer Session
Types:
File = Fil eTransfer Sessi on = #obj ref
Thisread only attribute represents the target object's associated Fi | eTr ansf er Sessi on.
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CosFileTransfer_Directory

CosFileTransfer_Directory

Erlang module

To get access to the record definitions for the structures use:
-include_lib("cosFileTransfer/include/*.hrl").

This module also exports the functions described in:

e CosFileTransfer_File
e CosPropertyService PropertySetDef in the cosProperty application.

Exports

list(Directory, Max) -> Return
Types.
Directory = #objref
Return = {ok, FileList, Filelterator}
FileList = [File]
File = Filelterator = #objref
This operation returns a list, of length Max or less, containing Object References representing files or directories

contained within the target Directory. If the amount of objects found is less than Max the returned Iterator will be
aNl L object.
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CosFileTransfer_Filelterator

CosFileTransfer_Filelterator

Erlang module

To get access to the record definitions for the structures use:
-include_lib("cosFileTransfer/include/*.hrl").

Exports

next _one(lterator) -> Return
Types.
I terator = #objref
Return = {bool ean(), #' CosFileTransfer FileWapper'{the file = File
file_type = Type}}
File = #objref
Type = nfile | ndirectory
This operation returns true if aFi | eW apper exists at the current position and the out parameter contains a valid
Fi | e reference. If false isreturned the out parameter isanon-valid Fi | eW apper .

next_n(lterator, Max) -> Return
Types:
Iterator = #objref
Max = unsigned | ong()
Return = {bool ean(), FilelList}
FileList = [# CosFileTransfer_FileWapper' {the file = File file_type =

Type}]
File = #objref
Type = nfile | ndirectory

This operation returns true if the requested number of Fi | eW apper s can be delivered and there are additional
Fi | eW apper s. If falseisreturned alist, of length Max or less, containingthelast validFi | eW apper s associated
with the target object.

destroy(lterator) -> ok
Types:
Iterator = #objref
This operation terminates the target object.
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CosFileTransfer_VirtualFileSystem

CosFileTransfer_VirtualFileSystem

Erlang module

To get access to the record definitions for the structures use:
-include_lib("cosFileTransfer/include/*.hrl").

Exports

' get file systemtype' (VFS) -> Return

Types.
VFS = #obj ref
Return = '"FTP'" | ' NATIVE

Thisread only attribute represents the target object's associated file system.

' _get _supported_content _types' (VFS) -> Return
Types:

VFS = #obj ref

Return =

Thisread only attribute represents the target object's supported content types.

| ogi n(VFS, User, Password, Account) -> Return
Types.
VFS = #obj ref
User = Password = Account = string()
Return = {Fil eTransferSession, Directory} | {'EXCEPTION,6 E}
Fil eTransferSession = Directory = #objref

This operation creates a new instance of aFi | eTr ansf er Sessi on and aDi r ect ory. The later represents the
current working directory of the returned Fi | eTr ansf er Sessi on.
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CosFileTransfer_FileTransferSession

CosFileTransfer_FileTransferSession

Erlang module

To get access to the record definitions for the structures use:
-include_lib("cosFileTransfer/include/*.hrl").

Exports

' _get _protocols_supported (FTS) -> Return

Types:
FTS = #obj ref
Return = [# CosFil eTransfer Protocol Support' {protocol nane=Type,
addr esses=[ Address] }]

Type = Address = string()
Thisread only attribute returns the protocol s supported by the target object.

set _directory(FTS, Directory) -> Return
Types.

FTS = Directory = #objref

Return = ok | {' EXCEPTION, E}

Invoking this operation will change the current working directory of the target object's associated file system. If fail
to do so the appropriate exception is raised.

create file(FTS, FileNaneList) -> Return
Types:
FTS = #objref
Fi | eNameLi st = [string()]
Return = File | {' EXCEPTION, E}
File = #objref
This operation creates a Fi | e Object representing a file which may or may not exist. For this operation to be
independent of the working directory the supplied Fi | eNameLi st must represent the absolute name.

create directory(FTS, FileNaneList) -> Return
Types.
FTS = #obj ref
Fi |l eNameLi st = [string()]
Return = Directory | {' EXCEPTION, E}
Directory = #objref

This operation creates anew directory in the target objects associated file systems domain. If fail to do so an exception
israised but, if successful, aDi r ect or y object representing the new directory is returned.

get _file(FTS, FileNaneList) -> Return
Types:
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CosFileTransfer_FileTransferSession

FTS = #obj ref
Fi | eNameLi st = [string()]
Return = Fil eWapper | {' EXCEPTION, E}
Fil eWapper = # CosFileTransfer_Fil eWapper'{the file = File file_type =
Type}
File = #objref
Type = nfile | ndirectory
This operation, creates a Fi | eW apper which represents a file or directory, and should be independent of the

working Directory, i.e., a full path name must be supplied. Furthermore, the file or directory represented by the
Fi | eNameLi st must exist.

del ete(FTS, File) -> Return
Types.
FTS = File = #objref
Return = ok | {' EXCEPTION , E}

This operation removes the file or directory, represented by the Fi | e object, from the target objects associated file
system. If it isanon-empty directory or non-existing file or directory an exception is raised.

transfer (FTS, SourceFile, DestinationFile) -> Return
Types:

FTS = SourceFile = DestinationFile = #objref

Return = ok | {' EXCEPTION , E}
If the target object's and the Desti nati onFi | e' s associated Fi | eTr ansf er Sessi on' s support the same
protocol(s) this operation will copy the file represented by the Sour ceFi | e from the target object'sfile system to a
fileinthedestination Fi | eTr ansf er Sessi on' s filesystem. Thefileisrepresented by theDest i nati onFi |l e

object and may not exist. This operation must be invoked on the Fi | eTr ansf er Sessi on associated with the
Sour ceFi | e object.

append( FTS, SourceFile, DestinationFile) -> Return
Types.
FTS = SourceFile = DestinationFile = #objref
Return = ok | {' EXCEPTION , E}

Thisoperation behavesamost likethet r ansf er / 3 operation. Thedifferenceisthat theDest i nat i onFi | e must
exist sincethe Sour ceFi | e will be appended to the Dest i nati onFi | e.

Currently, it is not possible to use this operation when the target object represents FTP.

i nsert (FTS, SourceFile, DestinationFile, Ofset) -> Return

Types:
FTS = SourceFile = DestinationFile = #objref
O fset = long()
Return = ok | {' EXCEPTION , E}

Thisoperation behavesamost liketheappend/ 3 operation. The differenceisthat the Sour ceFi | e will beinserted
into the Dest i nati onFi | e O f set bytesfrom the start of thefile.

Currently, it is not possible to use this operation when the target object represents FTP.
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CosFileTransfer_FileTransferSession

| ogout (FTS) -> ok
Types:
FTS = #objref
This operation terminates the target object and closes the connection to the file system it represents.
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